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PENDAHULUAN 

 

 

Dokumen Manual Penggunaan Templat (MPT) Building Information Modeling (BIM) Jabatan Kerja Raya (JKR) Struktur 

merupakan satu dokumen di peringkat jabatan yang dihasilkan untuk memberi panduan mengenai penggunaan Templat Struktur 

BIM JKR kepada para Jurutera Awam/Penolong Jurutera Awam JKR yang terlibat dalam projek yang dilaksanakan secara BIM. 

Dokumen ini menerangkan pengenalan, fungsi dan penggunaan templat yang disediakan oleh Unit BIM Cawangan Perancangan 

Aset Bersepadu (CPAB) JKR.  Dokumen ini merupakan lanjutan daripada penerangan pengenalan templat di dalam dokumen 

Piawaian BIM JKR serta penggunaan perisian yang terkandung di dalam dokumen Manual Proses Kerja BIM JKR. Dokumen ini 

menerangkan cara aplikasi perisian Revit bagi disiplin Struktur dengan menggunakan tetapan yang telah disesuaikan mengikut 

amalan terbaik pelaksanaan BIM. Sebahagian keterangan penggunaan templat ini adalah sebagai panduan kepada pengguna dan 

ianya boleh diubahsuai mengikut kesesuaian dan keperluan semasa. 

Dengan adanya Manual Penggunaan Templat BIM di dalam dokumen ini, diharapkan agar pembangunan model dapat dilaksanakan 

dengan lebih teratur berdasarkan Manual Proses Kerja BIM JKR supaya faedah penggunaan BIM dapat dimanfaatkan sepenuhnya 

di dalam sesebuah projek. 

Dokumen ini adalah terpakai untuk semua projek JKR yang dilaksanakan secara BIM. Penambahbaikan dokumen perlu 

dilaksanakan secara berterusan pada masa akan datang untuk disesuaikan dengan perkembangan teknologi BIM semasa serta 

bagi tujuan memperluaskan faedah dan skop penggunaan BIM. 

Akhir sekali, diharapkan agar dokumen ini dapat memberi kefahaman, pengetahuan dan maklumat berguna kepada semua pihak 

dalam merealisasikan proses kerja BIM yang lebih terancang, meningkatkan kompetensi para pegawai serta memberi nilai tambah 

kepada sistem penyampaian projek.
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MANUAL PENGGUNAAN TEMPLAT BIM JKR (STRUKTUR) 

 

1 PENGENALAN  

Templat ditakrifkan sebagai jenis fail yang telah dipiawaikan (standard). Ia juga digunakan di dalam perisian komputer sebagai 

contoh pra-format dan mengandungi satu set elemen tetapan bertujuan untuk mewujudkan keseragaman tetapan mengikut 

kehendak dan keperluan penggunaan yang berulang kali. 

Templat yang disediakan mengandungi tetapan seperti berikut: 

i. Project Information 

ii. Project Settings 

iii. Project Browser (Project Views) 

iv. View Template 

v. Parameter 

vi. Print Settings 

Templat Revit dibangunkan untuk membantu perekabentuk menyeragamkan tetapan, mempercepatkan penyediaan model 

dan dokumentasi yang konsisten. 

 

2 KONSEP PENGGUNAAN TEMPLAT BIM JKR (STRUKTUR) 

Templat Struktur BIM JKR telah dibangunkan dalam perisian Autodesk Revit (Format .rte). Templat ini disediakan dengan 

ketetapan umum yang lazim digunakan di dalam pembangunan Model Struktur. BIM Modeler akan menggunakan templat ini 

dalam proses pembangunan dan pengemaskinian Model Struktur. Semua maklumat rekabentuk, pembinaan dan aset akan 

diisi di dalam ruang yang terdapat dalam templat dari semasa ke semasa.  

Selain itu, templat ini juga boleh diubahsuai mengikut kesesuaian dan keperluan projek. Walau bagaimanapun, perkara ini 

perlu dirujuk atau dimaklumkan kepada Unit BIM sekiranya terdapat keperluan tambahan terhadap tetapan sedia ada di dalam 

templat. 

Rajah 1 menunjukkan carta alir umum konsep penggunaan Templat Struktur BIM JKR.  
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CARTA ALIR UMUM KONSEP PENGGUNAAN TEMPLATE BIM JKR REVIT STRUKTUR
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Muat naik Templat BIM 

.rte terkini ke dalam 

Pusat BIM

Muat turun Templat 

BIM .rte ke dalam 

Folder Projek

Semak Kesesuaian 

Template dengan 

Projek

Perlu

Perubahan Project

Browser?

Laksana 

Perubahan 

Project Browser

Ya

Tidak

Sedia Maklumbalas 

Penggunaan Templat

Kaji Kesesuaian 

Penambahbaikan 

Templat

Terima 

Permohonan

Laksana 

Penambahbaikan 

Templat (Jika 

Perlu)

Terima & Serah 

Maklumbalas 

Penggunaan Templat

Sedia Model 

BIM Struktur

Rekodkan 

Penambahbaikan 

Templat
TAMAT

 

Rajah 1: Carta alir umum konsep penggunaan Template BIM JKR  Revit Struktur
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Untuk memulakan proses pembangunan model, perekabentuk perlu mendapatkan templat Revit terkini melalui kaedah 

berikut. 

Kaedah Penggunaan 

Memulakan New Project 

i) Buka perisian Revit. Pada Application Menu  [1] > File [2] > New [3] > Project [4] 

 

 
 

ii) Klik Browse... [5] dan cari dan pilih fail Template Struktur yang terkini di dalam Pusat BIM > klik Open > pilih Project 

[6] > klik OK [7] 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 [1] 

[1] 

[2] 

  

[3] 
[4] 

 

 [5] 

[7] 

[6] 
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3 PEMBAHAGIAN TEMPLAT REVIT PROJEK STRUKTUR 

Templat Struktur BIM telah dibangunkan dengan menetapkan tetapan utama seperti berikut : 

i. Project Information 

ii. Structural Settings 

iii. Project Browser 

iv. View Template 

v. Parameter 

vi. Print Settings 

 

Fungsi dan cara penggunaan templat setiap tetapan utama yang digunakan di dalam projek akan diterangkan dalam bab 

seterusnya. 

 

 

Rajah 2: Paparan Muka (user interface) Perisian Revit  

 

Rajah 2 menunjukkan paparan muka perisian Revit dan penerangannya adalah seperti di bawah: 

No.  Penerangan   No. Penerangan 

1. Application button  9. Properties pallete 

2. Quick access toolbar  10. Type selector 

3. Info center  11. View cube navigation 

4. Tab  12. Steering wheels navigation 

5. Panel  13. Drawing area 

6. Ribbon  14. View control bar 

7. Tool/Icon  15. Status bar 

8. Project browser  16. Options bar 

  

[1] [2] 

 

   
 

 

 

 

 
 

[8] 

[7] [3] 

[5] 

[9] 

[10] 

[11] 

[12] 

[6] 

[4] 

[15] [14] [13] 

 [16] 
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4 PROJECT INFORMATION 

4.1 Pengenalan Project Information  

Project Information mengandungi informasi model sesebuah projek seperti nama dan alamat projek, status projek, nama dan 

alamat pelanggan, tarikh pelaksanaan projek dan lain-lain. Informasi ini akan dimasukkan secara berperingkat mengikut fasa 

pelaksanaan projek. Informasi yang terkandung di dalam Project Information juga boleh dimasukkan ke dalam jadual dan 

digunakan pada Title Block (Sheet). 

 

4.1.1 Project Information Interface   

Aturan untuk membuka Project Information Interface    adalah seperti berikut: 

Klik pada tab Manage > panel Settings >  Project Information 

 

Rajah 3: Project Information Interface 

 

4.2 Fungsi Project Information  

Project Information berfungsi sebagai pengkalan data yang menyimpan maklumat projek dan rekabentuk. Terdapat dua (2) 

sumber maklumat yang perlu dimasukkan ke dalam Project Information iaitu : 

i. Maklumat projek – Data yang diambil daripada fail model arkitek  

ii. Maklumat rekabentuk struktur – Data berkaitan rekabentuk struktur yang diisi oleh perekabentuk
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4.3 Penggunaan Project Information 

4.3.1 Menyalin Maklumat Sedia Ada Projek Daripada Fail Model Arkitek (Transfer Project Standards) 

ATURAN DAN KETERANGAN BERGAMBAR 

Memilih maklumat di dalam Project Info dan Project Parameter dalam Fail Model Arkitek yang hendak disalin. 

iii) Klik [1] tab Manage > [2]  Transfer Project Standards (pada panel Settings) 

 

 

 

iv) Pilih [3] Project Info > klik [4] OK 

 

 

[1] [2] 

 

[3] 

 

[4] 
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ATURAN DAN KETERANGAN BERGAMBAR 

v) Paparan maklumat [5] yang telah disalin. 

 

 

 

[5] 
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4.3.2 Mengisi Maklumat Berkaitan Rekabentuk Struktur ke dalam Model Struktur 

Kaedah Penggunaan 

Mengisi maklumat di dalam Project Information dan Project Parameter dalam Model Struktur 

 

vi) Klik [1] tab Manage > [2]   Project Information (pada panel Settings)  

 

 

 

vii) Isi maklumat pada ruang Value yang berkaitan [3] di dalam Project Properties  

viii) Klik [4] OK 

 

 

[2] [1] 
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Kaedah Penggunaan 

  

 

 

 
[3] 

 

 

[4] 
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5 STRUCTURAL SETTINGS 

5.1 Pengenalan Structural Settings 

Structural Settings merupakan tetapan piawaian bagi elemen analitikal di dalam model struktur.  

Tetapan parameter Analytical Model Settings telah ditetapkan di dalam Structural Settings manakala parameter Symbolic 

Representation Settings, Load Cases, Load Combinations, Analytical Model Settings dan Boundary Condition 

Settings perisian dikekalkan seperti sedia ada memandangkan parameter tersebut tidak digunakan di dalam analisis 

rekabentuk dan penyediaan model.   

 

5.1.1 Structural Settings Interface  

Paparan Structural Settings Interface adalah seperti berikut: 

 

 

Rajah 4: Structural Settings Interface 
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6 PROJECT BROWSER 

6.1 Pengenalan Project Browser 

Secara asasnya, Project Browser mengandungi elemen seperti berikut: 

i. Views 

ii. Legends 

iii. Schedules/Quantities 

iv. Sheets (Struktur) 

v. Families 

vi. Groups 

vii. Revit Links 

 

 

 

6.1.1 Project Browser Interface 

 

Rajah 5: Project Browser Interface bagi disiplin Struktur 

 

6.2 Fungsi Project Browser  

Fungsi Project Browser diterangkan di dalam Jadual 1 berikut : 

Jadual 1: Fungsi elemen di dalam Project Browser 

No. Element di dalam Project Browser Fungsi 

1. Views Untuk memaparkan elemen struktur di dalam pelbagai paparan seperti 
Structural Plans, 3D Views, Elevations, Sections dan Drafting Views 

2. Legends Untuk memaparkan simbol komponen struktur 

3. Schedules/Quantities Untuk memaparkan senarai maklumat rekabentuk, aset dan kuantiti 

4. Sheets (Struktur) Untuk mengurus dan memaparkan dokumentasi lukisan  

5. Families Untuk mengurus dan memaparkan senarai komponen struktur yang 
terdapat di dalam fail templat 

6. Groups Tidak berkaitan 

7. Revit Links Untuk  mengurus dan memaparkan fail – fail model yang dihubungkan di 
dalam projek 
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6.3 Penggunaan Project Browser 

6.3.1 Views 

Views memaparkan elemen struktur di dalam paparan 2D atau 3D. Views di dalam Templat Struktur ditetapkan seperti di 

dalam Jadual 2 berikut: 

Jadual 2: Keterangan Views yang terdapat di dalam templat 

No. Views Keterangan 

1. Structural Plans  

1.1 Working [1] 

 

Catatan:Templat ini hanya menyediakan 

level 00 Aras Asas dan 01 Aras Satu 

sahaja. 

Paparan asal yang digunakan untuk membangunkan model dan 

menunjukkan elemen-elemen yang wujud pada paparan tersebut. 

 

 

1.2 Pelan Asas [2] 

 

 

Paparan pelan susunatur bagi elemen struktur asas yang digunakan 

untuk tujuan dokumentasi 

 

 

 

 

 

 

 

 

 

[1] 

 

[2] 
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No. Views Keterangan 

1.3 Pelan Tiang [3] 

 

 

Paparan pelan susunatur bagi elemen struktur tiang yang digunakan 

untuk tujuan dokumentasi 

 

 

1.4 Pelan Rasuk [4] 

 

 

Paparan pelan susunatur bagi elemen struktur rasuk yang digunakan 

untuk tujuan dokumentasi 

 

 

1.5 Pelan Papak [5] 

 

 

Paparan pelan susunatur bagi elemen struktur papak yang digunakan 

untuk tujuan dokumentasi 

 

 

 

 

 

[3] 

 

[4] 

 

[5] 
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No. Views Keterangan 

1.6 Pelan Analytical [6] 

 

 

Paparan 2D yang menunjukkan elemen analitikal struktur  

 

 

2. 3D Views  

2.1 3D Model Analytical [7] 

 

 

Paparan 3D yang menunjukkan elemen analitikal struktur  

 

 

2.2 3D Model Koordinasi [8] 

 

 

Paparan 3D yang menunjukkan hasil gabungan antara model struktur 

dan model disiplin lain  

 

 

 

 

[6] 

 

[7] 

 

[8] 
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No. Views Keterangan 

2.3 3D Model Struktur [9] 

 

 

Paparan 3D yang menunjukkan model struktur dalam pelbagai 

perspektif 

 

 

2.4 Paparan 3D Paparan 3D (default) 

3. Elevations  

3.1 01 Utara Paparan pandangan utara/selatan 

 

 

3.2 02 Selatan [10] 

 

 

3.3 03 Timur Paparan pandangan timur/barat 

 

 

 

3.4 04 Barat [11] 

 

 

 

[9] 

 

[10] 

 

[11] 
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No. Views Keterangan 

4. Sections [12] 

 

 

Paparan keratan rentas bangunan dan elemen struktur 

 

 

5. Drafting Views [13] 

 

 

Paparan butiran terperinci elemen struktur  

 

 

 

 

 

 

 

 

 

 

 

 

[12] 

 

[13] 
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6.3.1.1 Mengemaskini Paparan Views – Structural Plans 

Aturan dan keterangan bergambar 

1. Mewujudkan Structural Plans

i. Klik [1] menu View > [2]  Plan Views > [3]  Structural Plans  

ii. Pilih Aras [4] yang ingin ditambah. Klik OK [5].

Catatan: Di dalam contoh ini, Aras Dua dan Aras Bumbung telah dibangunkan melalui perisian analisis dan rekabentuk yang 

dieksport ke dalam perisian Revit. 

[2] 

[1] 

[3] 

[5] 

[4]
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Aturan dan keterangan bergambar 

2. Apply View Template

i. Pilih 02 Aras Dua dalam Project Browser. Klik kanan > Duplicate View > Duplicate. Namakan aras baru (Rename)

sebagai 02 PELAN SUSUN ATUR RASUK ARAS DUA.

ii. Klik [1] tab View > View Template [2] > Apply Template Properties to Current View [3]

iii. Hasil pengemaskinian templat melalui penambahan aras baharu ditunjukkan seperti rajah di bawah.

Contoh hasil duplicate view untuk penambahan aras baharu (Aras Dua) 

Contoh hasil paparan menggunakan Apply View Template 

[2] 

[1] 
[3]
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6.3.1.2 Mengemaskini Paparan - 3D Views 

 

Aturan dan keterangan bergambar 

Menambah paparan 3D Views (Contoh : 3D View bagi Aras Dua) 

i. Pilih 00_01-3D Model Struktur Keseluruhan dalam Project Browser. Klik kanan > Duplicate View > 

Duplicate. Namakan paparan baru (Rename) sebagai 01_02-3D Model Struktur Aras Dua.  

   

Contoh hasil duplicate view untuk penambahan paparan 3D baharu (3D Model Struktur Aras Dua) 

 

ii. Klik drop down panel pada 3D View Cube [1] > pilih Orient to View > Floor Plans > Structural Plans: 02 

Aras Dua 

 

Contoh hasil paparan 3D bagi Aras Dua 

 

 

 

 

[1] 
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6.3.1.3 Mengemaskini Paparan – Elevations 

 

Aturan dan keterangan bergambar 

Mengemaskini paparan pandangan tampak (Contoh : Elevations : 02 Selatan) 

i. Kemaskini paparan pandangan tampak dari aspek susunan grid dan aras [1] dan penambahan dimensi untuk 

grid dan aras [2]. 

   

Contoh hasil paparan pandangan tampak Selatan yang telah dikemaskini 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[2] 

[1] 

 

 
 



MPT BIM JKR Revit Struktur                                                                                                            Ver.2019 

21 

6.3.1.4 Mengemaskini Paparan – Sections 

 

Aturan dan keterangan bergambar 

Mengemaskini paparan Sections (Contoh : Sections : 01 Keratan Bangunan) 

i. Kemaskini paparan keratan dengan mengubahsuai kotak View Range [1] paparan keratan yang 

dikehendaki. 

   

Contoh hasil paparan keratan bangunan yang telah dikemaskini 

 

Catatan: Keratan baharu boleh ditambah dengan menggunakan icon Section  

 

 

 

 

 

 

 

[2] 

[1] 
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6.3.1.5 Mengemaskini Paparan - Drafting Views 

 

Aturan dan keterangan bergambar 

1. Mengemaskini paparan Drafting Views (Contoh : Drafting Views : 01 Keratan Bangunan) 

Klik [1] menu View > [1]  Drafting View [2] > Namakan paparan tersebut sebagai 03_02 Perincian Rasuk - Aras Dua dan 

skala 1:25.  

   

 

2. Apply View Template 

Pilih 03_02 Perincian Rasuk - Aras Dua dalam Project Browser. Klik [1] menu View > View Template [2] > Apply Template 

Properties to Current View [3] > pilih jkrST_Structural Drafting View [3] > Klik OK [4]. 

 

    

Contoh hasil penambahan paparan drafting bagi lukisan CAD 

 

 

 

 

[2] 

[1] 

 

 [2] 

[1] 

 

 

[3] 

[4] 
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Aturan dan keterangan bergambar 

3. Memasukkan lukisan CAD ke dalam paparan Drafting View 

Klik [1] tab Insert > Import CAD [2] > masukkan lukisan CAD yang dikehendaki > klik OK. 

 

 

 

Contoh lukisan CAD yang telah diimport ke dalam paparan Drafting Views 

 

 

 

 

[2] [1] 

 



MPT BIM JKR Revit Struktur                                                                                                            Ver.2019 

24 

6.3.2 Legend 

Simbol komponen struktur ditunjukkan seperti rajah berikut : 

 

 

Rajah 6: Contoh Legend sepertimana di dalam Templat Revit Struktur 

 

 

Aturan dan keterangan bergambar 

Mengubahsuai Legends 

i. Buka Legend dalam Project Browser > buka paparan Structural Framing Legend [1]. Ubah simbol 

komponen di dalam Option Bar > Family [2] dengan membuka drop down panel tersebut. Pilih komponen 

yang dikehendaki. 

 

 

 

 

[1] 

 

 

[2] 



MPT BIM JKR Revit Struktur                                                                                                            Ver.2019 

25 

Aturan dan keterangan bergambar 

ii. Rajah di bawah menunjukkan pengubahsuaian Legend sepertimana yang dikehendaki untuk dimasukkan 

ke dalam dokumentasi lukisan 

 

 

 

 

6.3.3 Schedules/Quantities 

Schedules/Quantities merupakan jadual maklumat elemen dan komponen struktur yang dijana di dalam model secara 

automatik. Maklumat di dalam Schedules Properties telah ditetapkan di dalam templat yang mengandungi parameter elemen 

struktur yang diperlukan. Maklumat ini boleh ditambah atau dikurangkan mengikut kesesuaian dan keperluan. Terdapat tiga 

(3) jenis Schedules/Quantities di dalam templat yang disediakan iaitu: 

i. Schedules/Quantities bagi data rekabentuk [1] 

ii. Schedules/Quantities bagi data kuantiti bahan [2] 

iii. Schedules/Quantities bagi data rekod aset [3] 

 

Contoh Schedules/Quantities bagi Jadual Asas Penapak 

[Tajuk] 

 

 
[Komponen] 

 

[Nama 

Komponen] 
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Rajah 7: Contoh tetapan di dalam Schedules/Quantities 

 

 

Rajah 8: Schedules/Quantities bagi data rekabentuk 

 

 

[1] 
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Rajah 9: Schedules/Quantities bagi data kuantiti ukur bahan 

 

 

Rajah 10: Schedules/Quantities bagi data rekod aset 

 

[2] 

 

 

[3] 
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Aturan dan keterangan bergambar 

Menambah Schedules/Quantities baharu (Contoh : Jadual Rasuk Aras Dua) 

Pilih A 02_PC-02-Jadual Rasuk Aras Dua dalam Project Browser. Klik kanan > Duplicate View > Duplicate. Namakan 

paparan baru (Rename) sebagai A 02_PC-03-Jadual Rasuk Aras Bumbung [1]. Pada Properties > pilih Filter-Edit... [2]. 

Ubah kepada 03 Aras Bumbung [3] . klik OK [4]. 

   

 

 

 

 

 

[1] 

 

 

[2] 

 

[3] 

  

 

[4] 
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Aturan dan keterangan bergambar 

 

 

Contoh jadual rasuk pra-tuang untuk 03 Aras Bumbung 

 

 

 

6.3.4 Sheets 

Sheets merupakan ruang dokumentasi lukisan yang dijana melalui model. Senarai lukisan yang dijana adalah 

seperti berikut :   

 

 

Rajah 11: Sheets yang disediakan di dalam Templat Revit Struktur 
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Aturan dan keterangan bergambar 

Menambah Sheets (Contoh : Pelan Susunatur Rasuk Aras Dua) 

 

i. Pilih Sheets dalam Project Browser. Klik kanan > pilih New Sheets... [1] > pilih families title block yang 

dikehendaki > klik OK.  

 

 
 

ii. Namakan Sheets baru (Rename) sebagai: 

a. Number : LB-02 [2] 

b. Name :Pelan Susun Atur Rasuk -Aras Bumbung [3] 

c. Klik OK [4]. 

 

   

 

iii. Pada Properties > pilih 05-00 Pelan Rasuk [5] pada Sheet_jkr_pi. Sheets bagi LB-02 – Pelan Susun Atur 

Rasuk – Aras Bumbung akan dimasukkan ke dalam senarai 05-00 Pelan Rasuk. 

  

 

[1] 

 

 

[2] 

 

 
[3] 

 

 
[4] 

 

 

[5] 

 

 

[6] 
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Aturan dan keterangan bergambar 

 

iv. Drag and drop paparan bagi Views – 03 Pelan Rasuk - 03 PELAN SUSUN ATUR RASUK ARAS 

BUMBUNG [7] ke dalam Sheets - 05-00 Pelan Rasuk - Pelan Susun Atur Rasuk -Aras Bumbung [8]. 

 

 

 

6.3.5 Families  

Families menunjukkan senarai komponen struktur, annotation dan title block yang terdapat di dalam templat. Semua 

families boleh digunakan dan diubahsuai di dalam penyediaan model mengikut keperluan rekabentuk dan 

kesesuaian dokumentasi lukisan. Families boleh ditambah dan diperolehi daripada JKR BIM Library dari semasa 

ke semasa mengikut keperluan projek sekiranya tidak terdapat di dalam templat. Kaedah konvensyen penamaan 

bagi families perlu merujuk kepada Piawaian BIM JKR.  

Jadual 3: Keterangan Families yang terdapat di dalam templat 

No

. 
Families Keterangan 

1. Komponen struktur 

 

Contoh komponen struktur: 

i. Floors 

 

Contoh Floor: jkrST_str-fl_ip_slab-150mm 

 

 

 

 

 

[1] 

 

[7] 

 

 

[8] 
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No

. 
Families Keterangan 

ii. Structural Columns 

 

Contoh Structural Column: jkrST_str-cl_pc_CS 02-CR 02 

 

iii. Structural Foundation 

 

Contoh Structural Foundation: jkrST_str-fo_ip_spc 

 

iv. Structural Framing 

 

Contoh Structural Framing: jkrST_str-fr_ip_rcb 

 

v. Walls 

 

Contoh Structural Framing: jkrST_str-wl_ip_rc wall 
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No

. 
Families Keterangan 

2. Annotation-tagging 

 

Tagging [1]digunakan untuk melabel komponen struktur yang 

telah dimodelkan untuk tujuan mengenalpasti komponen 

struktur di dalam paparan. 

i. Klik tab Annotation > Pilih Tag All [1]  

 

 

ii. Pilih Category Tagging yang dikehendaki, sebagai contoh 

pilih Structural Framing Tags [2]  > klik OK [3]  

 

 

 

Contoh tagging label komponen rasuk di dalam paparan 

 

 

 

 

 

 

[1]  

[1] 

[2] 

 

 
[3] 
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No

. 
Families Keterangan 

3. Title Block 

 

Contoh Title Block: 

  

i. Title Block - Tajuk Projek 

 

 

ii. Title Block - Senarai Lukisan 

 

 

iii. Title Block – Saiz A3 

 

 

 

 

 

[1] 
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No

. 
Families Keterangan 

 

iv. Title Block A1 

 

v. Title Block – A0 

 

 
 

 

6.3.5.1 Memuatnaik families 

Aturan dan keterangan bergambar 

Memuatnaik komponen families struktur ke dalam projek 

 

i. Klik [1] tab Insert > Pilih Load Family [2]  

 

 

 

 

 

[1] [2] 
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Aturan dan keterangan bergambar 

ii. Pilih komponen families yang dikehendaki melalui proses muatnaik komponen families daripada Katalog 

IBS JKR di dalam JKR BIM Library. Sebagai contoh, dengan memilih komponen families jkrST16_str-

fr_pc_BR03 rasuk pra-tuang [3] > klik Open [4].  

 

 

 

 

Contoh komponen families yang telah dimuatnaik ke dalam projek 

 

 

 

 

 

 

[3] [4] 
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Aturan dan keterangan bergambar 

 

iii. Kemaskini maklumat rekabentuk seperti di bawah: 

a. Structural Materials [5] 

b. Gred Bahan [6] 

c. Rebar Cover [7] 

d. ID Komponen [8] 

 

 

Contoh komponen families yang telah dimuatnaik ke dalam projek 

 

 

 
[5] 

 

[7] 

 
[6] 

 
[8] 
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6.3.6 Revit Links 

Revit Links memaparkan model-model yang dihubungkan dengan model struktur bagi tujuan pembangunan model. Contoh 

model yang dihubungkan adalah seperti model arkitek, model elektrik, model mekanikal dan juga sub model struktur. 

Pengurusan Revit Links perlu diambil perhatian yang sewajarnya agar model yang dihubungkan ke dalam projek hendaklah 

tersusun dengan lebih sistematik, mudah dikendalikan, difahami dan merupakan model yang terkini. 

 

Aturan dan keterangan bergambar 

Menghubungkan model disiplin lain (Contoh : Link Model Revit Arkitek) 

 

i. Klik tab Insert [1] > Link Revit [2] (pada panel Link)  

 

 

ii. Pilih model Arkitek yang dikehendaki untuk dihubungkan ke dalam projek. Klik Open.  

iii. Model Arkitek telah dihubungkan ke dalam projek [4] melalui Revit Links [3]. 

 

 

 

 

 

 

[2] [1] 

 

 

[3] 

[4] 
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Aturan dan keterangan bergambar 

iv. Selain itu juga, model yang telah dihubungkan boleh dilihat di dalam tab Manage [5] > Manage Links [6] 

(pada panel Manage Project) 

 

 

 

 

Berikut merupakan fungsi setiap pilihan di dalam tetingkap Manage Links: 

a. Reload From... – Memuatnaik semula fail model lain yang telah dikemaskini atau diubahsuai 

b. Reload – Memuatnaik fail model yang telah di’Unload’ 

c. Unload – Memisahkan fail model yang telah digabungkan 

d. Remove – Membuang fail model yang telah digabungkan 

 

 

 

 

[5] [6] 
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6.3.7 Filter 

Filter merupakan tetapan untuk menyesuaikan grafik sesuatu element yang dikehendaki bagi paparan berkaitan. Ianya 

digunakan dengan menetapkan view filters mengikut elements yang dipilih melalui Categories serta penetapan parameter 

values di dalam Filter Rules.  

Aturan dan keterangan bergambar 

Penetapan Filter Rules 

 

i. Buka paparan Visibility/Graphic Overrides > Filters > klik Edit/New...[1] 

 
 

ii. Klik icon New [2] > Namakan sebagai Foundation-B2B9 [3] > klik OK [4] 

 

 

  

iii. Seterusnya di ruang Categories, tick (√) pada kekotak Structural Foundations [5]  > pada ruang Filter Rules [6], 

buat tetapan seperti berikut: 

a. Filter by: Type Mark 

b. Syarat filter: equals 

c. Parameter value: SP2A 

 

 

[3] 

[2] 

 

[4] 

 
[1] 
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Aturan dan keterangan bergambar 

 

iv. Klik OK [7]. 

 

v. Pada tetingkap Visibility/Graphic Overrides > klik Add [8] > masukkan Filter Foundation-B2B9 > ubah Patterns 

di ruang Projection/Surface sepertimana di bawah [9] > klik OK [10]. 

 

 

 

 

[6] 

[5]  

[7] 

 

 

[9] 

[10] 

 

[8] 
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Aturan dan keterangan bergambar 

 

Contoh paparan dalam penggunaan Filter pada elements Structural Foundations bagi jenis B2B9 
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7 VIEW TEMPLATE 

7.1 Pengenalan View Template 

View Template mengandungi beberapa parameter paparan yang boleh ditetapkan mengikut keperluan model dan 

dokumentasi lukisan. View Template yang terdapat di dalam templat ini adalah seperti berikut: 

1. 3D Views, Walkthrough 

a. jkrST_Structural Model & Analytical Combined 

b. jkrST_Structure 3D View 

c. jkrST_Structure Analytical 3D View 

d. jkrST_Structure Detailing 3D View 

 

2. Elevations, Sections, Detail Views 

a. jkrST_Structural Building Elevation 

b. jkrST_Structural Framing Elevation 

c. jkrST_Structural Section 

d. jkrST_Structural Section-Detailing 

e. jkrST_View Elevation 

 

3. Floor, Structural, Area Plans 

a. jkrST_Structural Analytical 

b. jkrST_Structural Plan-Beam Layout 

c. jkrST_Structural Plan-Column Layout 

d. jkrST_Structural Plan-Foundation 

e. jkrST_Structural Plan-Slab Layout 

f. jkrST_Structural Plan-WIP 

g. jkrST_Structural Site Plan 

 

4. Rendering, Drafting Views 

a. jkrST_Structural Drafting View 

 

Rajah 12: Contoh View Template 
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7.2 Fungsi View Template 

View Template membolehkan perekabentuk mempelbagaikan paparan yang dikehendaki dengan memilih parameter paparan 

berkaitan yang terdapat di dalam View Properties. 

 

7.3 Penggunaan View Template 

Perekabentuk boleh menambah View Template yang baharu sekiranya terdapat keperluan tambahan di dalam projek. 

Aturan dan keterangan bergambar 

Menggunakan View Template (Contoh : Apply View Template bagi kedudukan tiang pra-tuang) 

 

i. Di dalam Project Browser > Structural Plans > Workings > pilih 02 Aras Dua > klik kanan > Duplicate View > 

Duplicate. Namakan paparan tersebut sebagai 01 PELAN KEDUDUKAN TIANG PRATUANG ARAS DUA [1]. 

 

 

ii. Klik tab View [2] > View Template [3] > Apply Template Properties to Current View [4]. 

 

 

 

 

 

 

 

 

 

[1] 

 

[3] 

[2] 

 

[4] 
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Aturan dan keterangan bergambar 

iii. Pilih pilihan seperti berikut: 

a. Discipline filter: Structural [5] 

b. View Type filter: Floor/Structural Plan/Area Plan [6] 

c. Names: jkrST_Structural Plan-Column Layout [7] 

d. Klik OK [8]. 

 

 

 

 

Contoh hasil paparan pelan susun atur tiang pra-tuang 

 

[5] 

[7] 

 

[6]  

 

[8] 
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8 PARAMETER  

8.1 Pengenalan Parameter 

Parameter merupakan jenis data/maklumat yang ditetapkan di dalam Categories. Terdapat dua (2) jenis parameter iaitu Type 

dan Instance telah disediakan di dalam setiap Categories.  

i. Type – Ciri-ciri maklumat yang sama dan terdapat di dalam sesuatu komponen 

 

 

 

Rajah 13: Contoh maklumat yang diisi di dalam Type Parameter 

 

ii. Instance – Ciri-ciri maklumat yang sama/berbeza dan diisi di dalam sesuatu komponen secara 

berkumpulan/berasingan  

 

  

Rajah 14: Contoh maklumat yang diisi di dalam Instance Parameter 
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Maklumat parameter ini perlu diisi di dalam ruangan Value di sepanjang proses pembangunan model. Berikut adalah 

Categories yang terdapat di dalam templat :  

i. Project Information

ii. Sheets

iii. Views

iv. Structural Framings

v. Structural Columns

vi. Structural Foundations

vii. Floors

viii. Walls

Di antara parameter yang terdapat di dalam setiap categories ialah maklumat geometri (panjang,tebal,lebar, tinggi dan lain-

lain) dan maklumat bukan geometri (tarikh pemasangan,maklumat pembekal, jenis bahan dan lain-lain) 

8.2 Fungsi Parameter  

Terdapat dua (2) fungsi parameter iaitu : 

i. Membolehkan proses penyimpanan maklumat projek, rekabentuk, kuantiti bahan dan aset secara digital

ii. Membolehkan pengguna lain (Perekabentuk, Juruukur Bahan, Pengurus Projek, Kontraktor dan Pelanggan)

mendapatkan maklumat yang berkaitan dengan model/projek untuk digunakan dalam pelbagai tujuan.
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8.3 Penggunaan Parameter 

 

Aturan dan keterangan bergambar 

Mengemaskini parameter di dalam komponen families (Contoh : Komponen families rasuk) 

 

i. Pilih salah satu komponen rasuk [1]. Properties rasuk akan ditunjukkan dalam tetingkap Properties [2].  

 

 

 

 

 

 

 

 

 

 

 

 

[2] [1] 
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Aturan dan keterangan bergambar 

ii. Contoh pengisian maklumat parameter Type seperti berikut:

Parameter Maklumat/Data 

Structural 

Section Shape Not Defined  

Dimensions 

b 300 

h 600 

Identity Data 

Fire Rating 2 jam 

Description Rasuk Pra-Tuang  

Type Mark 300 x 600 

Data 

Jenis_jkr_stt Rectangle Beam 

Kaedah_Pemasangan_jkr_stt Pra-Tuang 

Kod_DAK_Komponen_jkr_stt  T.B 

Saiz_Fizikal_jkr_stt  300mm x 600mm 

Sistem_jkr_stt Struktur Utama 

Sub_Sistem_jkr_stt Kerangka (Frame) 

General 

Nota_jkr_stt 
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Aturan dan keterangan bergambar 

iii. Contoh pengisian maklumat parameter Instance seperti berikut: 

Instance Framing 

Materials and Finishes   

Structural Material 
jkrSTm_Concrete - Cast In Place Concrete 
– C28/35 

Structural    

Gred Bahan_jkr_sit C28/35 

Cut Length 8750 

Structural Usage Other 

Enable Analytical Model    

Rebar Cover - Top Face  
jkrST_Exterior/Interior - Floor Beam <25 
mm> 

Rebar Cover - Bottom Face  
jkrST_Exterior/Interior - Floor Beam <25 
mm> 

Rebar Cover – Other Faces 
jkrST_Exterior/Interior - Floor Beam <25 
mm> 

Dimensions   

Length 9000 

Volume 1.144 

Identity Data   

ID_Rasuk_jkr_sit RB1 

Mark RB1-1 

Level_jkr_sit Aras Dua 

General   

Kod_DAK_Lokasi_jkr_sit C-02-027 

Data   

Jangka_Hayat_jkr_sit 50 Tahun  

No_Siri_jkr_sit D20160101-1EP 

No_Tel_Pembekal_jkr_sit 03-2618 7888 

Pembekal_jkr_sit ABC Supplier Sdn. Bhd. 

Pengilang_jkr_sit Eastern Pretect (Malaysia) Sdn. Bhd.  

Tarikh_Dipasang_jkr_sit 01 Januari 2017 

Tarikh_Waranti_Tamat_jkr_sit 01 Januari 2022 
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9 PRINT SETTINGS 

9.1 Pengenalan Print Settings 

Print Settings merupakan tetapan yang disediakan bagi mencetak lukisan yang dikehendaki.  

 

 

Rajah 15: Contoh tetapan Print Settings 

 

9.2 Fungsi Print Settings 

Print Settings membolehkan perekabentuk memilih kepelbagaian paparan melalui Set Print yang disediakan. 
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9.3 Penggunaan Print Settings 

Aturan dan keterangan bergambar 

Memilih lukisan yang ingin dicetak  di dalam Print Settings (Contoh: Mencetak Lukisan Pelan Susun Atur) 

i. Terdapat tiga (3) pilihan yang telah disediakan di dalam templat iaitu:

a. jkrST-01-Print Layout – mencetak lukisan pelan susunatur

b. jkrST-02-Print Details – mencetak lukisan butiran terperinci

c. jkrST-03-Print Layout & Details – mencetak lukisan pelan susunatur dan butiran terperinci

ii. Pada Application Revit > pilih Print > pilih Print. Klik Select [4] di bawah Print Range di dalam tetingkap

Print.

[2] 

[1] 

[3] 

[4]
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Aturan dan keterangan bergambar 

iii. Pilih jkrST-01-Print Layout [5] > ‘untick’ View [6] > tick pada senarai Pelan Susun Atur yang dikehendaki [7] 

> klik Save [8] > klik OK [9].  

 

 

iv. Pilih pencetak [10] yang dikehendaki untuk mencetak lukisan-lukisan yang telah di tetapkan di dalam Print 

Rage-Selected Views/Sheets [11]. 

v. Klik OK [12] untuk mencetak lukisan.  

 

 

 

 

  

 

[6] 

[8] 

 

[5] 

[7] 

 
[9] 

 

 

 

[10] 

[11] 

[12] 
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